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Picasa Introduction and Tutorial

From the creators of Google, Picasa (http://www.picasa.google.com/) IS a
free image organizing and simple editing program that is installed on
each computer in every migrated school. You can also download it at
home to view, edit and organize your photo collection.

Meeting the Maryland Teacher & Student Technology S  tandards

The state of Maryland recently drafted and passed technology standards for
students and teachers. For detailed information regarding the standards, you can
view the teacher standards (http://www.mttsonline.org/standards/) online or get a
printable copy (http://www.mttsonline.org/standards/MDTchrTechStdsMTTS.pdf) of
the standards and indicators. Here is a link for the student technology standards
(http://www.mcps.k12.md.us/departments/techlit/). Look in the second column and
click on a link to see a particular grade level's standards. Below are the student
and teacher standards that are met when using this program with students in class
and for students during instruction.

* Maryland Teacher Technology Standards:

o Standard 1- Information Access, Evaluation, Processing and
Application: Access, evaluate, process and apply information
efficiently and effectively.

o Standard 3- Legal, Social and Ethical Issues: Demonstrate an
understanding of the legal, social and ethical issues related to
technology use.

o Standard 7- Professional Growth: Develop professional practices that
support continual learning and professional growth in technology.

* Maryland Technology Literacy Standards for Students

o Standard 2- Digital Citizenship: Demonstrate an understanding of
the history of technology and its impact on society, and practice
ethical, legal, and responsible use of technology to assure safety.

o Standard 3- Technology for Learning and Collaboration: Use a
variety of technologies for learning and collaboration.

o Standard 4- Technology for Communication and Expression: Use
technology to communicate information and express ideas using
various media formats.

o Standard 5- Technology for Information Use and Management: Use
technology to locate, evaluate, gather, and organize information
and data.

What is Picasa, and why would | use it?
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As mentioned in the introduction, Picasa is an image organizing program. The
first time that you open it, it will scan your hard drive and index, or locate, all
photographs, screen shots, icons and other images. Picasa only indexes the
images instead of making a copy and doubling the size of your image collection.
It also allows users to make slight changes to images and place pictures in
albums. Note: Picasa automatically indexes all images on your hard drive, which
includes your My Documents folder. The My Documents folder on your home PC
is a folder found on the hard drive (C:/). However, those that work at a migrated
school have their home directory (H:/) named My Documents.

There are many reasons to take digital images with your class. Whether it is to
promote exemplary work, photograph students who receive awards or for
yearbook spreads, photographs can quickly get buried in subfolders when
uploaded from a digital camera. It is important to make sure that you upload
pictures to folders with names that make sense so you don’t have to search for a
long time. The same general rules of file management apply to digital photos.
Here are some sample uses for the program in school:

Examples of using the program Examples of using the program

WITH students

FOR instruction

1.

Allow students to copy
pictures from a shared drive
to their home directory so
they can edit and categorize
the images for a project.

1. Organize a collection of

pictures from different
climates or geographical
spots that students can
access.

Have students create a
timeline of events from a
folder of images.

. Create a slideshow of

pictures to brainstorm ideas
for a new project or to
highlight student success or
best practices.

3.

Allow class to copy pictures
to their local directory and
add personal captions that
can be used in a
presentation.

. Create a collage out of

images in various folders as a
culminating activity.

Before we begin...

As with any other program, it should be noted that Picasa is subject to copyright
laws and local, state or federal regulations. If you have a question about our
Acceptable Use Policy or copyright issues, speak with your tech coordinator or
media specialist. If they are unsure, contact tech services for more information.
There are some additional considerations any time that you take a picture of a
student. Here are some general guidelines of acceptable use with this program:

Frederick County Public Schools- Technology Services
Picasa Instructions and Use- Page 2 of 13



Last modified: 4/14/2010

* Music that accompanies a slide show in Picasa must be copyright-free;
songs from personal .mp3 collections or iPod libraries may not be used.

» Teachers that publish (upload to a web site) photos must check that
permission has NOT denied to have student work published. This is found
at the bottom of the emergency card.

* Make sure that any photographs imported into the program or used by
students do not violate any copyright laws (i.e. saving a picture from an
artist's website and importing it into Picasa).

Using Picasa 3

Launch Picasa from the MULTIMEDIA folder on the Application Launder.

™ A
4w Launch Picasa.exe

The first time that you install the program, it will index (locate) all the images.
This process allows Picasa to recognize where you keep all of the images on
your machine- including pictures, screen shots and any images found on
websites that were saved locally.

Choose the option to scan “My Documents, My Pictures, and the Desktop.”
Otherwise, it will scan the entire school network and take quite a long time. You
can add pictures from folders at a later time.

Picasa is ready to scan for pictures on your computer

Completely scan my computer for pictures

Choose this option if you have pictures stored in various folders across your computer, especially if
you have pictures stored on more than one hard drive.

@ Only scan My Documents, My Pictures, and the Desktop

Choose this option if you only store your pictures in the above folders.

scanning for pictures never moves or copies files to new locations. You can choase which folders are displayed
by Picasa by using the Folder Manager tool (available from the Tools menu)

When prompted, you can choose to use the Picasa Photo Viewer or not. It will
allow you to look at your pictures quickly and easily when you click on them.

Picasa’s menu bar contains some familiar tasks and some that you may not have
heard of before. Here are the most common tasks listed under each menu:

(Figure 1- Picasa’s menu options)

* File menu: Modify the status of a file
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o0 Add files and folders, save another copy of the picture, print or
email a photo.
* Edit menu: Adjust the properties of an object
o Cut, copy, paste and select all.
* View menu: Change how you view files and folders
o View smaller or larger image icons, add keywords or captions to
pictures.
* Folder menu: Make a change that affects an entire f  older
o Change a folder description, view a folder in a slideshow, locate the
folder on the hard drive, make a web-based picture page or print a
contact page.
* Picture menu: Modify one picture or multiple pictur es simultaneously
o Edit a single picture, batch edit multiple files or undo all edits at once.
» Create menu: Produce creative multimedia files
o Create posters, collages, movies from pictures and post pictures to
an online blog (web log).
» Tools menu: Make changes to Picasa or your computer with Picasa
o Create a backup copy of all pictures, set screensavers and change
program options.
* Help menu: User assistance for Picasa
0 Get assistance for general topics or use the help index, check for
updates and locate online user forums.

Adding or importing pictures

Picasa can be set up to automatically detect new multimedia images when
devices (digital cameras, flash keys) connect to the computer. In Windows XP, a
dialogue box will appear any time you connect a USB device or put a CD into the
drive bay. If the item has any image files (.jpg, .png, .gif, etc.) you will see an
option that allows you to import the images into Picasa.

Users can also manually import pictures from a CD, flash or network drive. This
option works well if you want to save images to a location first before indexing
them in the program. To do this, click the Import button under the menu bar.
Then, click the Import From menu to choose the device from which to import. At
the bottom of the screen, tell Picasa where you want to put the imported pictures.

Picasa 3
Import from: Remaovable Drive(D:,
File Edit ‘“iew Folds P [ (G4 n
J&i* Import Exclude Duplicates
9
Import to: Folder title:

| My Pictures n | |5ummer n
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Viewing images in the program

Once your pictures have been imported into Picasa, they will be organized into a
Library. The Library is organized by topics:

f’.AIbums{ib

V& Recently Updated (8)

v ) People (1)

! Scanning; 10% complete

v ) Folders (232)

mages (2

* Albums - You can create a custom photo album of just the pictures you
want

* People — Picasa has facial recognition to group and label people in your
collection

» Folders — Picasa scans your computer and organizes the pictures it finds
by the folder name and date.

Under the View menu, you'll see a variety of different choices. You can view
smaller or larger images, many pictures or one picture at a time. Finally, you can
view the images as a slideshow or a timeline and set automatic controls- this is a
great way to show many pictures without having to stop a discussion or
presentation and clicking the next image. Teachers with a data projector could
run a rolling presentation on back to school night so that parents waiting to speak
with the teacher could get a glimpse into the daily happenings of the classroom.
Make sure that you get parent permission to take a student’s photograph if you
plan on doing this.
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Organizing Photos

Having pictures in folders is only a rudimentary way to organize your collection.
As the collection grows, it becomes more difficult to find the pictures you want.
Picasa has three main ways to address this. At the bottom right corner of the
window you will see these three buttons.

1 People ? Places = Tags

Tags (From Google Help)
http://picasa.google.com/support/bin/answer.py?enrs®06209

Tags are like keywords. By applying single or multiple-word tags in Picasa, you
can quickly search and locate your photos. To add a tag to a photo, please follow
these steps:

1. Select the photos that you'd like to tag by using SHIFT+click or
CTRL+click. You can only tag photos in one folder or album at a time.

2. Click the Tags button. You can also use the keyboard shortcut Ctrl-T
(Windows) or Command-T (Mac). Existing tags and tag counts for
selected photos will be listed in the 'Tags' tab.

3. There are two ways to add tags:

o Type the tag manually : Use the text box to enter the tag and click
the 'Add tag' button.

o Use your 'Quick Tags' : By presetting tags that you frequently use,
you can add them with the click of a button. Manage your 'Quick

Tags' by clicking the 'Configure Quick Tags' icon in the 'Tags'
tab.
To remove a tag from all selected photos, just hover over the relevant tag in the
Tags panel and click the 'x' icon that appears.
Once your photos are tagged, you can use the search box in the upper right-
hand corner of Picasa to quickly find pictures that you've tagged.

Geotagging Pictures: Add geotags in Picasa (From Go  ogle Help)
http://picasa.google.com/support/bin/answer.py?ans®61869

Use Google Maps in Picasa to place your photos on the map. This is good for a
collection of photos about a specific region that you are studying or have visited.
To geotag a photo, follow these steps:

1. Select the photos you'd like to geotag. | "= : g
2. Click the Places button in the lower |7 =2 = ) T
right corner of Picasa. R BT T i m

3. Navigate to or search for your location. !LI ] !

4. Click the green marker button to add a

TR ?:” L
new place for selected photos. Move E m m : ket
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the green marker to the spot where you took the photos.
5. Click the OK button to finalize the geotag.
You can also drag-and-drop photos directly onto the map.
Picasa will write the longitude and latitude to the photo's EXIF metadata. You can
view this data (GPS Latitude and Longitude) by right-clicking (Windows) Control-
clicking (Mac) a geotagged image in Picasa and selecting Properties .

Geotagged photos are marked with a icon when viewed in Picasa.

People: Add name tags in Picasa (From Google Help)
http://picasa.google.com/support/bin/answer.py?ans®b6272

Picasa's face-matching technology lets you organize your photos according to
the people in them. The first time you open Picasa, it will scan your photos for
new faces, since name tags are turned on by default. It can take some time to
scan all your photos, however you can start adding name tags whenever you'd
like. Follow these steps:

1. Signin to Picasa Web Albums.
Click Sign in to Web Albums in the upper right corner of Picasa. This lets you
use your Google contacts when adding hame tags.

2. Add name tags in bulk or a few photos at a time.
In bulk : Click on the 'Unnamed People' album in the 'People’ collection.
Unnamed faces across all of your photos are grouped here. Each face thumbnail
in the album represents a group of similar faces, so adding a name to a face
thumbnail applies the same name to all the faces in the group. To see all the
faces in a given group, click the People button (next to the Photo Tray) to open
the 'People' tab on the right.

(=]

o
& Unnamed people Expand Qivups Show igored taces

Unramsed peogle in thes phatas

A few photos at a time : Click the People button next to the Photo Tray when
viewing any folder, album, or photo. The resulting '‘People’ tab on the right
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displays all the faces that appear in the selected photos, including those without
name tags.

e<] ()

People in these photos:

Falco
3 photos

| Add a name

3. Click 'Add a name' under any face and type a name
As you type a name, Picasa searches your Google contacts and displays
matches. Select a name from the suggested matches to add it as a name tag. Or
type the name and press Enter to create a new contact -- this name tag will be
added as a new contact in your list of Google contacts.
When you add a new name tag, Picasa creates a corresponding people album in

the 'People’ collection. Use the button in the album to zoom in on the
faces you've identified or to view the photos in their entirety.

You don't have to name everyone. Deleting an unnamed face or clicking the [x]
icon on a photo will place that photo in the 'Ignored’ aloum. You can view the
photos you've ignored at any time by clicking Show ignored faces at the top of
the 'Unnamed People’ album.

4. Confirm Picasa face suggestions.
Picasa uses the names you add to automatically add face suggestions to your

albums. If you see an orange question mark |:|next to a people album, go to the

album and confirm these suggestions. Click Elto keep the photo or D o
remove the photo from the album. If there are multiple suggestions, you can click
Confirm all at the top of the alboum to mark all the suggestions as correct. Toggle

2%lat the top to see just the suggested faces.

Don't worry if you make a mistake when adding name tags -- if a face winds up in

the wrong people album, select the photo and click the Remove button at the top

(or press the Delete key on your keyboard) to send it back to the ‘Unnamed

People' album. Learn more about deleting name tags.

Tips:

« Add name tags manually : If Picasa misses a face in your photo, you can
add it by clicking the Add a person manually button at the bottom of the
'People’ tab when viewing the photo.
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« Change profile photos : You can change the photo displayed next to
each album in the People collection. Just right-click (Windows) or Control-
click (Mac) the face you'd like to use and select Set as Album
Thumbnail .

« Download name tags from Picasa Web Albums : In Picasa, go to Tools
> Download Name Tags from Picasa Web Albums  to take advantage of
the name tags you've previously added online.

« Choose which folders to scan for faces : Just click Tools > Folder
Manager and toggle face detection on/off for any folder.

For the current folder:

M—'? 5can Once

x Remaove from Picasa

) e scan Always

@ Face Detection On

Add a Caption

To add a caption to a picture, double-click an image. Then, at the bottom of the
screen, left-click where it says “Make a caption!” You can add a caption, but will
only see a limited number of characters (about 10) if you view the pictures in the
smallest mode.

i A ——— Click here to see a caption when
1024x768 pixels  154KB (7 of 16) viewing the image in Picasa.

(Figure 3- making captions)

When you view images in the program, you will now see a
caption under each image. This will not rename the file.
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(Figure 4- sample captions under a picture collection)
Editing images in the program

Aside from being a great way to organize and view pictures, Picasa can be used
as a basic image editor. While you lack the high-powered tools found in
professional editing programs like Adobe Photoshop, the tools offered are easy
enough for most students to understand. Students and teachers alike can easily
crop and resize images, as well as changing the lighting effects. Picasa has one
effect called I'm feeling lucky that automatically makes the changes for you.

For example, a picture with too much contrast or not enough light is automatically
adjusted. Sometimes you won’t see much of a difference, but other times the
program will make drastic changes to the image. You can always undo the effect
or add additional effects if necessary.

To edit an image, you must be in the editing mode. Double-click an image to
enter this mode. In the top left corner of the program, you have three tabs: Basic
fixes, Tuning and Effects . Next to each screen shot below, you will see a short
description of the effects located under each tab:

1. Crop — select part of the picture

Basic Fixes Tuning Effects .
to view; removes excess space
: in a photo and gives you only
=T e “ the part you want.
Crop Stralghten Redeye 2. Straighten - straighten a

crooked image
— —= 3. Redeye — removes appearance

- i - PSS . of red eye created by a flash.

I'm Feeling Lucky  Auto Contrast Auto Color 4. I'm Fee”ng LUCky — Have
- — Picasa choose the effects to
W— Eﬁ*“[!'i make the image look better.

5. Auto Contrast — Automatically
change the contrast of the photo
— Fill Light 6. Auto Color — Automatically
E adjust the color levels
7. Retouch — Repair blemishes,
dust and scratches from a photo
8. Text — Add text to a photo
9. Fill Light — Manually lighten or darken a photo

Retouch Text
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Basic Fixes Tuning L Effects.
1. Fill Light — Manually lighten
) Fill Light or darken a photo
[1] 2. Highlight — manually make
. the lighter pixels in the image

- e brighter
[ {3 - 3. Shadows — manually make
the darker pictures in the
SHEE image darker

1) 4. Color Temperature —
manually add a slight blue or

Eol T ar red tint to the image

Nautral Color Pickir One Click Fix_ — Click this button and
_ l Picasa will automatically adjust the
. 2 “ 7 tuning properties for you

There are 12 different effects. Click on
one of the to see how it changes the
image. If you don't like it, click the
UNDO button below.

If you want to edit all the pictures in a folder, you can use a feature called Batch
edit. This simply means that you will add one or more effects to multiple files at
the same time. This is a very efficient way to change the naming convention,
orientation or contrast of many images.

All changes made in Picasa can easily be undone. Simply click the Undo button
after changing an image. The Redo button allows you to go back to that effect.
You can undo and redo multiple effects one at a time.
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NOTE: Picasa changes how the image looks when viewed in the program. You
are not actually making changes to the digital file itself. For example, if you want
to email a picture that you modified, the original image will be attached. If you
want to print or email the modified file, you must first save the changes to the file
in Picasa. To do this, you need to click the Save Changes button above the
folder in the picture gallery.

maine 09
Jun 29, 2009

> | |1.|

Picasa also creates a backup file, so if you double click on a picture (even after
exiting the program) you can undo the save, which will return the file to its
original condition.

Publishing and sharing features in Picasa

After you import, edit and save your files, you are ready to publish them.
Published files can mean sending them in email, creating a collage, screensaver,
or even a basic web page.

Emailing pictures is a simple task. FCPS does not support the use of Gmail
(Google’s email client) or Picasa’s Hello mail service, but users with these
accounts can log in and email pictures from Picasa. Outlook client (not OWA)
users can also mail pictures from this program. Select the images that you want
to email. Hold down the control key to select multiple images. Then, click the
Email button to begin. Follow

1 - S

Upload Ermail Print Expaort Shop BlogThis! Collage Maoiie sen-Tag

Collage

You have total artistic control over your collage content and layout. Experiment
with six different collage types in the hands-on collage creation screen. To create
a collage, follow the instructions below: Creating collages are a great way for you
to share images. Collages allow users to view multiple pictures on the same
screen. In Picasa, these images can be viewed as a picture pile (unorganized,
random array of images) or a contact sheet or picture grid (organized
arrangement) and you can even save your collage as your computer’s desktop
image. To learn more go to the Google Help Topic found at http://bit.ly/dDz7p3.
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Creating a Photo Movie

Picasa has added the ability to create a photo movie, similar to a slide show but
with more robust.

Combine your photos, videos, and music into a mane convert it to a .wmv
(Windows) or .mov (Mac) file. Share it with frientg uploading it directly to YouTube.
To create a movie, you can follow these steps:

1. Select the photos and videysu'd like to include in your movie.

ke

2. Click theMovie button in the Photo Tray to go to the 'Movie Maker"
screen. You can also create a movie for all phiot@sy folder or album by

e

clicking theCreate Movie Presentation button in the folder or album
header.
o Use theMovieg, Slide, andClipstabs to alter movie settings, add text to
slides, or insert new photos respectively. When ar@usatisfied with your
creation, you have a few options:
o Click thePlay full screen button in the lower-right corner of the screen to
see a full-screen preview.
o Click theCreate Movie button to begin the creation process.
o Click theYouTube button to create the movie and automatically ughiba
to YouTube.

Click the link below to view the full tutorial from Google:
http://bit.ly/GK5Zu

Additional resources

Article on using Picasa with students from www.techlearning.com:
http://www.techlearning.com/story/showArticle.php?articlelD=192200105

Picasa’s web-based help site: http://bit.ly/YAMU

Wikipedia’s Picasa page: http://en.wikipedia.org/wiki/Picasa
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